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More than once, I had sworn “I am going to learn 

how to use Adobe Flash.” I had resolved to branch 

out from my lifelong print-centric comfort zone 

and get hip. So I’d crank up Flash, meditate on the 

interface that looked so little like my old friends 

Photoshop and Illustrator, and say to myself,  “I think 

I’ll go do some laundry.”

I secretly envied designers who could make their 

content wiggle and bark, and dreamed that someday 

I’d be able to do that, too. But, frankly, Flash intimi-

dated me.

Then along came Adobe InDesign CS5, with a hefty 

arsenal of new interactive tools, accompanied by the 

new Adobe Flash Catalyst CS5—both refreshingly 

code-free. 

Suddenly, there was hope.

Introduction
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Who Should Read This Book
If you’re a print designer who has memorized most of the Pantone color 
numbers but has no idea what hexadecimal color codes are, being able to 
use familiar tools to create interactive content would be a new lease on your 
professional life. If you’re feeling a bit obsolete when you see coders whip out 
onscreen magic, don’t give up. You don’t have to completely retrain your brain.

As a print designer, you’ve accumulated years of design savvy, honed your  
visual instincts, and practiced your production chops. And not a minute of 
that experience will be wasted when you begin designing pages for the Web. 
You don’t have to start over; you can hit the ground running, because you 
already know how to use the foundation tools in InDesign, Photoshop, and 
Illustrator. And even though you’ve never used it, you’ll find the Flash Catalyst 
interface friendly and intuitive.

Instead of having to switch gears completely, you can build on what you  
already know, and apply your capabilities to interactive projects. This book 
can get you off to a good start on your new adventure.

What You’ll Get Out of This Book
While there isn’t room in this book to walk you through every single feature  
in InDesign, Photoshop, Illustrator, Flash Catalyst, and Flash Professional, 
you’ll pick up valuable new techniques for adding interactivity, including:

 ■ Awakening InDesign’s secret built-in Animation Encyclopedia

 ■ Animating InDesign page content with motion presets

 ■ Controlling the speed and play order of animations

 ■ Creating and applying custom motion presets

 ■ Creating custom button artwork in Photoshop, Illustrator, and InDesign

 ■ Importing video content and controlling poster and player options

 ■ Exporting to Flash Professional (and learning what’s lost in translation)

 ■ Editing animations in Flash Professional

 ■ Using the intuitive Heads Up Display in Flash Catalyst to turn Illustrator 
and Photoshop documents into interactive projects

 ■ Refining your files for online, in-house, or disc deployment

And you’ll do all of this without writing a single line of code!
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What I hope you get out of this book is a sense of relief (This isn’t so hard after 
all!) and a bit of inspiration (This is actually fun!).

What This Book is Not
This book doesn’t presume to teach you design principles. I’m a mechanic, 
not a designer. You’re the designer. All I can provide is insight into the inner 
workings of these tools. I’m counting on you to make it look good!

This is not a programming book. It’s devoted to helping you avoid writing 
code. But don’t let that scare you away from the more technical possibilities. 
Mere mortals can learn ActionScript and make Flash Professional sing. I’ve 
written JavaScript to enhance Adobe Acrobat forms, and I am definitely not a 
programmer. It may be that this book will whet your appetite and inspire you 
to dig deeper into what you used to think were foreign territories. That would 
make me proud.

Software Requirements
Unless you’re planning on just reading this book at the beach (unlikely), you’ll 
need all the appropriate software to play along. The following Adobe applica-
tions are used in the exercises:

 ■ InDesign CS5

 ■ Photoshop CS5

 ■ Illustrator CS5

 ■ Flash Catalyst CS5

 ■ Flash Professional CS5

If you have Adobe Creative Suite 5 Design Premium or Adobe Creative Suite 5 
Master Collection, you have all the necessary software. 

As for hardware requirements, as long as you have sufficient horsepower  
to run the required software, you’re fully equipped. It wouldn’t hurt to have 
sufficient RAM that you can run several applications simultaneously, and 
there’s no such thing as too much hard drive space. See www.adobe.com/
products/creativesuite for official system requirements.

If you have your own Web site, you’ll be able to upload finished project files 
and test them. If not, you can test them on your own computer.

www.adobe.com/products/
www.adobe.com/products/
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About the Exercise Files
The exercise files used in this book are organized by chapter on the CD. You 
can copy them all to your hard drive before you start working, or copy the  
exercise files for each chapter as needed. (Note: There are no exercise files  
for Chapter 6.) Because you will be working on and saving components of 
projects, then combining those components into finished work, it will be 
easier (and saner) to work off your local hard drive rather than trying to work 
off the CD. Most of the exercises include final versions of the working files  
and final exported SWF files so you can check your work. There is no home-
work, and there are no tests (unless you count your boss asking, “Hey, since I 
gave you that book yesterday, can you have that interactive portfolio ready in 
the morning?”).

All fonts required by the exercises are installed with Creative Suite 5, so you 
should not encounter any “missing font” messages unless you’ve manually 
modified your repository of fonts.

While you’re welcome to rework and experiment with any content in the  
exercises, please don’t use any of the images or artwork commercially.

Acknowledgments
When I first saw the interactive features in InDesign CS5 and met the new  
kid on the block, Flash Catalyst, I was smitten. I thought, “I should write a 
book.” So I have to thank the gifted Adobe software wizards who somehow 
manage to think up compelling new features with every release. I’m con-
vinced they have access to alien technology. (Have you seen Content Aware 
Fill in Photoshop CS5? I rest my case.)

My thanks to Susan Rimerman for thinking this book might be a good idea, 
and for exercising industrial-strength patience. It was a treat to work once 
again with Lisa Brazieal as production editor. Jean-Claude Tremblay was  
invaluable as an eagle-eyed technical editor, and offered indispensable insight 
into Flash Professional. I owe him something a bit more tangible than gratitude. 
(I only hope he doesn’t say, “Oh, a Lamborghini will do.”) And while being  
edited might be an unconventional way to gain a new friend, that’s what  
happened as a result of having the delightful Erfert Fenton as an editor. I hope 
to actually meet all these people someday.
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While previous versions of InDesign allowed you to 

create hyperlinks and import video and sound files, 

the InDesign document itself was static; none of the 

page content wiggled or barked. While InDesign 

CS4 introduced the ability to import SWF files and to 

export to the SWF format, the resulting SWF was still 

just a container for content that had to be created 

elsewhere. But InDesign CS5 allows you to do so much 

more—now, page content itself can be animated.  

Here’s where the real fun begins!

Animation 
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What Can Be Animated?
Any text frame, graphics frame, or empty frame (or group of frames) can be 
animated. As you saw in Chapter 3, “Multimedia,” a frame containing an 
FLV or FV4 video can be animated, but the video inside the frame won’t play 
until the animated frame calms down and stops doing whatever it’s doing. 
However, remember that a frame containing a placed SWF file can be animated, 
and the animation inside the frame will play while its container is doing 
something else (as long as something triggers the SWF to play). Think of the 
fiendish possibilities!

Exploring the Possibilities
There’s a great little guide to InDesign’s animation capabilities built right into 
the application, but you have to do a little digging to find it. First, you have to 
find a script that ships with InDesign. The script generates an InDesign docu-
ment containing examples of objects using many of the animation controls. 
You can examine each object’s settings in the Animation and Timing panels 
and learn a lot. 

 1. To start your quest for the Animation Encyclopedia (its official name), 
open the Scripts panel (Window > Utilities > Scripts). You’ll see two folders:  
Application and User. The User folder stores scripts you download to 
add to InDesign’s functionality (the scripts displayed are those installed by 
the currently active computer user); the Application folder contains the 
scripts that ship with InDesign (Figure 4.1). 

Figure 4.1 Sample scripts 
are supplied in two formats 
for Windows (JavaScript and 
VBScript) and two formats 
for Mac (JavaScript and 
AppleScript). All application 
scripts are available in both 
formats; only JavaScript is 
cross-platform.

 2. You’ll have to keep digging. Click the triangle next to the Application 
folder to view the Samples folder. Here’s where the road forks: If you’re 
using Windows, you’ll see subfolders for VBScript and JavaScript; on the 
Mac, you’ll have subfolders for AppleScript and JavaScript. The script  
selection is actually the same in both subfolders, so it doesn’t matter 
which you select for the next step; you’re almost there. Click the triangle 
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next to JavaScript, VBScript, or AppleScript, and there it is (fi nally): 
AnimationEncyclopedia (Figure 4.2).

Figure 4.2 You’ll find the AnimationEncyclopedia 
script in the JavaScript, AppleScript, or VBScript 
folder (depending on your platform). You’ll see 
VBScript on Windows, and AppleScript on the 
Mac. JavaScript is cross-platform.

 3. Double-click the script to run it. InDesign takes the reins and builds a 
six-page document. It may not look very exciting at fi rst (Figure 4.3), 
but it packs a secret punch. Preview the document and play along. Some 
objects require that you click them or the page, and some will be triggered 
when the page loads.

Figure 4.3 The design of the Animation Encyclopedia may not be compelling, but the beauty is 
under the hood. Preview this simple document, and prepare to be amazed. 
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The document that’s created is named Untitled.indd; I suggest you save it as  
AnimationEncyclopedia.indd and put it in a safe place. You can learn a lot 
about InDesign’s animation capabilities by examining the settings used by 
those little rectangles. Just so you know, page 6 of the document displays very 
complex behavior that’s beyond what you can do with just the animation and 
timing settings; it’s accomplished with scripting (as are the Color Fade and 
Combination effects on page 1). To give you an idea of its complexity, look at 
an excerpt from the JavaScript version of the Animation Encyclopedia script 
(Figure 4.4).

Don’t freak out—you’re not expected to write code like this! All the behaviors 
you see on pages 1 through 5 of the encyclopedia—and many more—can 
be achieved by using the controls and options in the Animation and Timing 
panels. The inclusion of the over-the-top performance on page 6 is to expose 
you to the fact that animation, like every other operation in InDesign, is com-
pletely scriptable. For this and other reasons, it’s a good idea to befriend a 
scripter and take him/her to lunch occasionally. 

Figure 4.4 Scripting 
can accomplish complex 
animations far beyond what’s 
possible with the motion and 
timing controls.
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Events
An animation requires two components: the object or objects being ani-
mated, and an event to trigger the playing of the animation. Th e triggering 
event could be the click of a button, a click of the animated object itself, or 
just the loading of the page on which the animation was created. Now you’ll 
do some exploring, so you can see how easy it is to make simple objects do 
your bidding. 

On Page Load
Th e default animation-triggering event is the simplest: Th e animation plays 
when the reader reaches the page (or opens the document, if the page is the 
fi rst—or only—page).

 1. Launch InDesign, navigate to the Ch_4_Exercises folder, and open 
Events_Start.indd. Before changing anything in the fi le, resave the fi le 
as Events_Working.indd. If necessary, choose the Interactive workspace 
from the Control panel (unless you have a custom panel arrangement for 
the interactive panels and don’t want to alter that).

 2. Notice the caption beneath each object, describing the trigger that will set 
the object’s animation in motion (Figure 4.5). Select one of the objects 
and look in the Animation panel; nobody home. You’ll create the anima-
tions and set up the event triggers. If you’re curious, you can preview a 
fi nished version of the fi le in the exercises folder (Events_Done.indd).

On Page LOad On Page CLiCk On CLiCk  
(seLf)

On ROLL OveR 
(seLf)

On ButtOn event 

 3. Select the green globe with the “On Page Load” caption and open the 
Animation panel. Rename the object GreenGlobe. (It’s helpful to give 
objects names you’ll recognize when you set up animations.) While each 
object in this page is unique, how would you address the correct circle 
in a page full of circles? By its name, of course. By the way, renaming the 
object in the Animation panel also changes its name in the Layers panel 
(and vice versa).

Figure 4.5 The caption under 
each object specifies the event 
that will trigger the object’s 
animation. You’ll create each 
animation behavior and set up 
the event triggers.
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 4. In the Animation panel, choose Fly in from Top from the Preset pull-down 
menu. A charming lavender butterfly demonstrates the animation for 
you. The Event option should already be set to the default, On Page Load 
(Figure 4.6). If you don’t see all the options, click the triangle to the left  
of Properties to reveal more of the panel. Leave all the other options 
at their defaults. Check the results in the Preview panel (Window > 
Interactive > Preview). Save the file and keep it open. There’s more fun  
to be had.

Figure 4.6 Set the GreenGlobe 
object to fly in from the top of 
the page on page load.

On Page Click
You may find that you rarely use the On Page Click event as a trigger for  
animation, since a reader probably wouldn’t feel the urge to click the page 
unless invited to do so. Artwork or text would have to give the reader a hint, 
or nothing would ever happen. But you never know when it might come in 
handy, so here goes. 

 1. Select the embossed orange square, and then choose Fly Out > Fly Out 
Top from the Preset pull-down menu (the Fly Out Top option is available 
in the submenu of the Fly Out option).
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 2. Th e Events pull-down menu control isn’t obvious; it’s a tiny triangle about 
an inch to the right of the Event(s) label in the Animation panel, and it 
comprises about six pixels. Squint a bit, and you’ll fi nd it (Figure 4.7). 
Th e triangle is a small target, but you can activate it by clicking the name 
of the existing event: On Page Load. (You can also click a bit to the left of 
the pull-down triangle and activate it.)

Figure 4.7 The Event options 
are available when you click 
the tiny triangle to the right of 
the Event(s) option. Could it 
be any more subtle?

Once you’ve found the miniature triangle, click it and choose On Page 
Click from the menu. 

 3. IMPORTANT: Choosing the On Page Click option does not override the 
original On Page Load trigger; this is easy to overlook when you’re in a 
hurry. Go back to the same menu and select On Page Load to toggle it off . 
Otherwise, the orange square will fl y upward when the page loads, before 
the user has an opportunity to click the page, thus spoiling the surprise. In 
the Preview panel, wait for the green globe to fl y in from the top, and then 
click in the Preview panel to set the orange square in motion. Be sure to 
click in an empty part of the page (despite the temptation to click on the 
orange square) to prove to yourself that it’s the page click that does the 
trick. Save the fi le and keep it open.

On Click (Self)
If you want the reader to click on an object to wake it up, use the On Click 
(Self) event. Th e term may seem odd; after all, the object can’t click itself. 
But it just means that the animation is triggered by clicking the object itself, 
rather than by clicking an external trigger. 

 1. Select the red heart-shaped object, and change its name to Heart in the 
Animation panel. Choose the Pulse animation from the Preset pull-down 
(it’s in the bottom part of the long list of presets). 

 2. Now that you’ve found the elusive Events pull-down triangle, choose the 
On Click (Self) option. Be sure to go back and toggle the default On Page 
Load option off .
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 3. Test the file in the Preview panel; click the heart and watch it beat hyp-
notically. If you like, experiment with the duration of the pulse, and set 
the number of times to 2 or 3. Remember this around Valentine’s Day (or 
Halloween). Save the file and keep it open.

As with the On Page Click option, something has to lure the reader to click 
on the object to trigger its animation. While a “Click Me!” label might be a 
bit inelegant, something must provide a hint, or the heart will never have a 
chance to beat.

On Roll Over (Self)
Now that you know that “(Self)” refers to the animated object itself, it’s obvi-
ous that the On Roll Over (Self) event triggers an animation when the reader 
rolls over the animated object. You’ll use the rollover event to make the blue 
half-circle spin around.

 1. Select the blue object, and change its name to HalfCircle in the Animation 
panel. Choose the On Roll Over (Self) event, and then choose the Rotate >  
Rotate 180° CW option from the Preset pull-down menu. Remember to  
toggle the On Page Load event off. Test the half-circle in the Preview panel.

 2. Try holding the mouse on the half-circle, and you’ll see that the half-circle 
keeps rotating. That’s one oddity about using the rollover event as the  
trigger for an animation that keeps an object in the same location: If the 
user doesn’t move the mouse away from the object, the animation is  
repeatedly triggered. Save the file and keep it open.

Note that when you choose the On Roll Over (Self) event, a new option  
appears in the Animation panel: Reverse on Roll Off. This would reverse (or 
undo) the animation move caused by the Roll Over event. For example, if the 
Reverse on Roll Off option is checked and you rotate an object 90 degrees 
clockwise by rolling over it, the object will rotate back to its original orienta-
tion when you roll off it. 

On Button Event
One of the most common methods you’ll use to trigger an animation is a button  
click. You must create the animation (even if it’s just a temporary version of 
the animation) before setting up the button, or the button has nothing to 
hook up to. (In Chapter 5, “Button Up,” you’ll learn how to create cool button 
artwork in Adobe Photoshop, Adobe Illustrator, and Adobe InDesign.)
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 1. Select the purple doughnut shape. Name it Doughnut in the Animation 
panel, and select the Grow option from the Preset pull-down. Set the  
scale factor to 150%, and choose the On Page Load event to toggle it off,  
in preparation for triggering the growing animation with a button.

 2. Select the gray button in the bottom right corner of the page, and open 
the Buttons panel (Window > Interactive > Buttons) to set it up. Choose 
the default On Release event, and click the plus sign next to Actions to 
select Animation (in the SWF section of the menu). 

 3. Note that when you select the Animation action, the panel changes in 
response, adding a pull-down menu that allows you to select which ani-
mation is triggered, and to select from options including Play, Stop, Pause, 
and Resume. Select the Doughnut animation and the default Play option. 
Test the file in the Preview panel. Export the file if you’d like to view it in 
a browser. You’re finished with this exercise, so you can save the file for 
future reference and then close it. 

Think about how the animated piece is presented, either in the Preview panel 
or in a browser. You knew where and what to click, because you were adding 
the interactive features. But would a reader, stumbling onto your Web page, 
know where to click? Probably not. This exercise was meant to familiarize you  
with the controls and options, not to create a final piece that would be pub-
lished online. But when you start creating your own animations, you’ll have to  
provide hints to the reader so they don’t miss out on some of the fun, especially 
if the animated objects are hidden when the reader first views the document.

Combining Animations 
If you were intrigued by the multiple behaviors of the object on page 6 of 
the Animation Encyclopedia, but don’t have the time or inclination to learn 
scripting, you can cheat. I mean, use a workaround. 

An animated object can be grouped with other objects, and then the group can 
be animated, resulting in a second behavior added to the original animation. 
Buttons can be grouped with other objects in a group that becomes animated, 
giving you the ability to make buttons move. You can keep nesting animations 
inside animations until… well, as long as your conscience will allow.

 1. In the Ch_4_Exercises folder, open MultiMoveStart.indd. Resave the file 
as MultiMoveWorking.indd in the same folder. The objects in the page 
have already been named in the Layers panel, which will save you some 

TIP: You can also create a 
relationship between the ani-
mation and the button right in 
the Animation panel. Click the 
Create Button Trigger icon ( ) 
in the Animation panel, and 
then click the button that will 
act as the trigger. If the trig-
ger object is not yet a button, 
you’re given the opportunity to 
make it a button.
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time (approximately half a second) when you animate them. If you like, 
preview the finished version of the project, MultiMoveDone.indd.

 2. Select the yellow star with a solid red stroke. In the Animation panel, 
choose the Grow preset, set the Duration to 2 seconds, and set the final 
scale factor to 200%. Be sure that the center point is selected in the scale 
orientation control ( ) in the Animation panel, so the star scales up from 
the center. Test the growing star in the Preview panel. 

 3. Select the light-blue square, and send it behind the star in stacking order: 
Object > Arrange > Send to Back. Select the light-blue square and center it 
under the yellow star (Smart Guides can make this easy). If you’re not sure 
the blue square and yellow star are perfectly centered, select them both, 
open the Align panel (Window > Object & Layout > Align), and use the 
vertical and horizontal center operations (Figure 4.8). It’s even easier to 
use the alignment icons in the Control panel.

Figure 4.8 Make sure 
the yellow star is perfectly 
centered on the blue 
square by clicking the Align 
Horizontal Centers icon and 
then the Align Vertical Centers 
icon in the Align panel.

 4. Now you’ll start piling on the animations. Group the blue square and  
yellow star together, and snap the group to the lower-left corner of the 
page. In the Animation panel, rename the group StarSquare, choose the 
Fly In From Top preset, and set the Duration to 2 seconds. The intention  
is to have the star-and-square group drop in from the top of the page, 
while the star scales simultaneously. But when you preview the anima-
tion, it clearly needs more work. You need to modify the length of the 
fly-in from the top of the page, as well as synchronize the fly-in and the 
scaling of the star.
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 5. If necessary, reselect the group so you can see the bright green fly-in path 
(Figure 4.9). Notice that it has little nodes. Yes, this means that you can 
edit any motion path. Click the path (the “bulb” at the top is probably the 
easiest target), and you’ll see a narrow bounding box appear around the 
path. The goal is to stretch the top anchor point on the path up to the top 
edge of the page. Pull up on the top anchor point—and it snaps back to its 
original position. Aargh! (This is a peculiarity of the Fly in from Top and 
Fly in from Bottom presets.)

  Here’s the trick: Switch to the Direct Selection tool (white arrow). The 
bounding box disappears, and the motion path now appears as a hairline. 
Click on the tiny top anchor point, hold down the Shift key (lest the path 
wander left or right), and drag straight up until you touch the top edge of 
the page. You can also set up the length and position of the motion path in 
the measurements fields in the Control panel, but you may find selecting 
and dragging easier and more intuitive.

 6. The star should grow as the star-and-square group falls from the top of 
the page, so you’ll have to synchronize the star’s growth with the square’s 
fall. Switch back to the black arrow, and reselect the group. In the Timing 
panel, Shift-click to select both the tacky star and StarSquare anima-
tions, and click the link icon to synchronize them (Figure 4.10). Now, the 
scaling of the star and the group’s aerial drop will occur simultaneously. 
Preview the results, save the file, and keep it open for the grand finale.

Figure 4.10 Select the tacky star 
and StarSquare animations and 
synchronize them by clicking on 
the small link icon at the bottom 
of the Timing panel.

 7. Now you’ll add another animation, to send the star-and-square group flying  
off the page to the right. Select the empty rectangle on the page, and move 
it to the lower-left corner so it’s aligned with the star-and-square group; 
the lower-left corner of the group should be aligned with the lower-left  
corner of the page. Select all the objects and group them (Object > Group). 

TIP: There’s a shortcut to the 
Timing panel at the bottom of 
the Animation panel: Just click 
the Timing panel icon ( ).

Figure 4.9 The anchor points 
provide a hint that you can 
edit the motion path just like 
any other Bézier path.
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 8. In the Animation panel, name the new group FinalGroup, and choose the 
Fly Out > Fly Out Right preset. You’ll have to edit the preset motion path 
so that the FinalGroup flies all the way off the right side of the page.

 9. If necessary, select the FinalGroup object so you can see its bright-green 
motion path. Unlike the Fly in from Top motion path, this path can be 
edited without switching to the Direct Selection tool (only the Fly In from 
Top and Fly In from Bottom presets have this limitation). Select the path 
itself, click the green arrowhead on the end of the path, and drag the arrow-
head to the right until it’s far enough off the page that the star-and-square 
group will disappear at the end of its travel. Look up in the Control panel; 
the total length of the path (the “L” field) should be about 425 px. 

 10. You’ll make one last change; rather than having the star-and-square group 
fade out as it exits, you’ll keep it solid. In the Animation panel, change 
the Opacity setting from Fade Out to None. Preview the final animation, 
tweak if you want, and then save and close the file.

This is just a simple example, but it gives you an idea of what’s possible with-
out learning how to script InDesign. I don’t mean to imply that this is a good 
thing to do, from a design standpoint; this is one of those “just because you 
can, doesn’t mean you should” situations. The potential for garish, annoying 
animations is limitless. I feel guilty even showing this to you (you’re welcome).

Motion Presets
As you probably noticed while working through the previous exercises, InDesign 
includes an extensive assortment of motion presets to get your content moving 
(Figure 4.11). The presets are the same ones you’ll find in Adobe Flash CS5 
Professional, and you can also import any custom presets that have been  
created in Flash Professional. You can create custom motion presets in 
InDesign, save them for future use, and share them with other InDesign users 
or Flash designers. There’s just no end to the flying, dancing, bouncing fun  
you can have with motion settings.

TIP: Sometimes it’s easier  
to modify the behavior of an 
animation if you choose the 
Animation Proxy view mode. 
Click the Animation Proxy icon 
on the bottom of the Animation 
panel ( ) to see “ghosts” of 
the object at the start and end 
points of the animation path.
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Figure 4.11 How many motion presets 
ship with InDesign? Feast your eyes. And 
restrain yourself—you don’t have to use 
every single one in your project. The motion 
presets below the dividing line include 
special effects such as multiple stops or 
disappearing in smoke.

But maybe that’s not enough for you. Maybe you want more.

Motion Paths
If you want to make an object move along a more interesting path than just 
straight up or left to right, it’s surprisingly easy to do: You just have to draw the 
path you want the object to follow. You can use the Line tool, the Pen tool, or 
the Pencil tool—anything that creates a Bézier path. The path can be a simple 
straight line or a complicated curlicue. The stroke attributes of the line aren’t 
important; its appearance is discarded once it’s designated as a motion path.
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Creating a Custom Motion Preset
In this exercise, you’ll work on a child’s birthday party invitation, modifying 
existing presets and saving them as custom presets. You will also be creating 
several custom motion paths and saving their settings as custom presets.

 1. Navigate to the Motion Presets folder inside the Ch_4_Exercises folder, 
and open InviteStart.indd. Resave the file as InviteWorking.indd in the 
same folder. If you want to see the finished file, open InviteDone.indd 
and preview it.

 2. In the Layers panel, make sure the Moon layer is selected and unlocked. 
Select the Line tool ( ), and draw a diagonal line from the center of 
the blue moon to the upper-right corner of the page (Figure 4.12). Leave 
some room for the moon to grow larger as it rises.

Figure 4.12 Using the Line 
tool, start at the center of 
the moon, and drag up to 
the upper-right corner of the 
page. Don’t go all the way to 
the corner; leave some room 
for the moon to grow larger.

 3. Now you’ll convert the diagonal line to a motion path. Select both the 
path and the moon, and click the Convert to Motion Path icon ( )  
at the bottom of the Animation panel. Use the following settings:

■	 Event: On Page Load

■	 Duration: 2 seconds

■	 Speed: Ease Out

■	 Animate: From Current Appearance

■	 Animate Scale: 150%

■	 Visibility: Hide Until Animated
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  These settings will hide the moon until it begins to rise and grow larger. If 
necessary, tweak the length and angle of the path—you have to allow for 
the increase in the diameter of the moon so it isn’t cropped by the edge of 
the page.

 4. Lock the Moon layer, and click the visibility control by the Once in a Blue 
Moon layer to make it visible. Select the layer to target it.

 5. Using either the Pen or the Pencil tool, create a curved path that will  
bring the “Once in a Blue Moon” text in along a short counterclockwise 
arc (Figure 4.13). Start below the text, and end the curved path near the 
center of the text. You’ll designate this path as a motion path after you 
choose the initial motion preset.

Figure 4.13 Create a short, 
counterclockwise arc to guide 
the blue text up to the top of 
the page.

 6. In the Animation panel, choose the Fade In preset as a start, and use the 
following settings:

■	 Event: On Page Load

■	 Duration: 2.5 seconds

■	 Speed: From Preset  

■	 Animate: To Current Location

■	 Animate Scale: 120%

■	 Visibility: Hide Until Animated

 7. Select the arc path and the text (which have already been converted to 
outlines), and click the Convert to Motion Path icon at the bottom of  
the Animation panel.
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 8. The moon should start rising, followed by the appearance of the text.  
Use the Timing panel to control when each component plays. Select both 
animations in the Timing panel, and click the Play Together link at the 
bottom of the panel (Figure 4.14). (Ignore the existing animation in the 
Timing panel; it will make its appearance later in the exercise.) Preview 
the animation, save the file, and keep it open.

Figure 4.14 Synchronize the 
moonrise and the blue text so 
they play together.

 9. Now you’ll create a motion path and save it as a custom preset that you 
can use for other objects. Hide the Party, Once in a Blue Moon, and 
Moon layers. Reveal the Balloons layer, and select it to target it. With  
the Pen or Pencil tool, create an S-shaped path that starts at the center 
of the green-and-purple balloon and stops short of the top of the page 
(Figure 4.15). You’ll probably want to tweak the path after you test the 
animation; you want the balloon to float upward, but not off the page. 
Remember that the stroke attributes of the path aren’t important; it  
becomes invisible once it’s designated as a motion path.

Figure 4.15 Create an 
S-shaped path for the  
green-and-purple balloon to 
follow as it floats upward.
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 10. Select the balloon and the path, and click the Convert to Motion Path icon 
at the bottom of the Animation panel. Use the following settings:

■	 Event: On Page Load

■	 Duration: 3 seconds

■	 Speed: None

■	 Animate: From Current Appearance

■	 Animate Scale: 100%

■	 Opacity: Fade Out

 11. To save the balloon motion as a motion preset, choose Save from the 
Animation panel menu. Name the motion preset Balloon Float in the 
Save Preset dialog (Figure 4.16) and click OK. 

Figure 4.16 Name your new 
motion preset.

1 2. Now you’ll apply the new custom motion preset to the other balloon. 
Select the purple-and-yellow balloon, and choose the Balloon Float pre-
set in the Animation panel; notice that it’s displayed in a separate part  
of the Preset pull-down menu, near the top. That’s where your custom  
presets will appear. Examine the settings. Everything you specified for  
the first balloon has been stored in the preset, giving you a big head start 
on the second balloon. Change one thing: Set the Opacity to None, so the 
second balloon doesn’t fade out.

1 3. Preview the animation. Reposition the purple-and-yellow balloon if it flies 
off the left side of the page. If you wish to edit the balloon’s motion path, 
select the balloon, then switch to the white arrow and select the motion 
path. Once it’s selected, you can move, add, or delete anchor points to 
change its travel. Such edits will not alter the custom motion preset you 
created—the changes will apply just to this balloon’s animation.

1 4. It would be nice if the second balloon appeared in front of the text at the 
top of the invitation. In the Layers panel, turn the visibility of the Once  
in a Blue Moon layer back on, and unlock the layer. Select the purple-
and-yellow balloon in the Balloons layer, and use the small blue target 
square in the Balloons layer to push the balloon up to the topmost layer 
(Figure 4.17).
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Figure 4.17 Move the purple-
and-yellow balloon up to the 
Once in a Blue Moon layer 
by pushing the blue target 
square up to the top layer.

1 5. Reveal the Party layer, and select the “We Have a Party” text. In the 
Animation panel, choose the Fade In preset and use the following settings:

■	 Event: On Page Load

■	 Duration: 3.5 seconds

■	 Speed: From Preset

■	 Animate: From Current Appearance

■	 Animate Scale: 200%

■	 Opacity: Fade In

■	 Visibility: Hide Until Animated

1 6. Finally, reveal all layers. The text in the You’re Invited layer has already 
been animated. All you have to do is slightly rearrange the order in the 
Timing panel and link most of the animations together.

1 7. In the Timing panel, drag the Invited.ai animation to the bottom of the 
list. Drag balloon.ai and balloon2.ai up in the timing list so they’re just 
below BlueMoon.ai (Figure 4.18). Select all of the animations except 
Invited.ai, and link them so they start together on page load. They have 
different durations, so they don’t all finish simultaneously. Preview the 
animation, save the file, and keep it open.

Figure 4.18 Arrange the 
animations in the Timing 
panel as shown. Link all the 
animations except Invited.ai.
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Exporting and Importing Motion Presets
Motion presets are not document-specific. When you save a preset, it be-
comes part of InDesign’s arsenal for all documents. You should save the 
Balloon Float preset in case you ever need it again.

 1. From the Animation panel menu, choose Manage Presets. Select the 
Balloon Float preset at the top of the list, and then click the Save As 
button. You can save motion presets anywhere; they’re just XML files. 
Navigate to the Motion Presets folder inside the Ch_4_Exercises folder, 
name the preset BalloonFloat.xml, and click Save. You have to save pre-
sets one at a time, so if you want to store multiple custom presets, you’ll 
have to export them like this, one by one. Keep the Manage Presets dialog 
open for the next step.

 2. So you’ll know how to import custom motion presets, you’ll delete the 
Balloon Float preset and then re-import it. Select the Balloon Float pre-
set and click the Delete button. InDesign warns you that there is no undo 
for this move (Figure 4.19); click OK.

Figure 4.19 InDesign warns 
you that deleting a motion 
preset in the Manage Presets 
dialog cannot be undone.

 3 . Back in the Manage Presets dialog, click the Load button, navigate to the 
folder where you saved the BalloonFloat.xml file, select the file, and click 
Open. Although you must save presets one at a time, you can load mul-
tiple motion presets at once. Preview the file one last time, and tweak any-
thing you’d like to change. You’re finished with this exercise; you can close 
the file.

In this exercise, you played with a number of motion presets, learned how to 
create and use a motion path, and learned how to save and load custom mo-
tion presets. You should feel more familiar with the controls in the Animation 
panel and the wonderful selection of motion presets InDesign gives you. You 
should also be starting to get a sense of how you can combine durations and 
animation order in the Timing panel to make things happen when you want. 
And it’s all pretty easy, isn’t it?
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Page Transitions
As the user navigates from page to page in your project, it’s (usually) obvious 
to them that they’re reading through a multipage document. If you provide 
buttons that lead them to the next page, they’ll click on a “next page” button 
and the current page will be replaced by the next one (more about that in the 
next chapter). But if you’d like a fancier transition from one page to another, 
you might want to explore InDesign’s built-in page transitions. You may have 
seen the default Page Curl (way too cute), but there are others.

 1. In the Page Transitions folder inside the Ch_4_Exercises folder, open 
Paintings.indd. Resave the file as PaintingsWorking.indd in the same 
folder. Drag on the corner of the Preview panel so that you can more eas-
ily experiment with the default page curl, and set it to Preview Document 
mode ( ). If necessary, click the Play triangle in the bottom left corner 
of the Preview panel to render the document. Hover your cursor over the  
upper-right or lower-right corner of the cover page of the project, and you’ll 
see the “paper” start to curl, much like a real magazine page. Hold down 
the mouse button and keep dragging toward the left side of the Preview 
window, and the experience is much like turning the page in a magazine 
printed on very thin paper (Figure 4.20). In fact, you may find it difficult 
to let go of the page in order to complete the transition to the next page—
it’s sort of like that scene in National Lampoon’s Christmas Vacation when 
Chevy Chase is trying to read a magazine with pine sap on his hands. You’ll 
be relieved to know that the experience is much better in the exported SWF.

Figure 4.20 The default SWF 
page curl is similar to turning 
pages in a printed magazine.

NOTE: If the page curl effect 
isn’t working in the Preview 
panel, choose Edit Preview 
Settings from the Preview panel 
menu, and make sure that the 
Include Interactive Page Curl 
option is checked. You may 
have to refresh the Preview 
panel by Alt/Option-clicking 
the play icon on the bottom of 
the panel.
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 2. Launch your default Web browser, choose File > Open File, navigate to 
the PaintingsExport folder inside the Page Transitions folder, and open 
Paintings.html. Try turning the pages in your Web browser, and you 
should find that the page-turning behavior is much more natural. When 
you drag far enough toward the opposite side of the screen, the page should 
turn—and stay that way. Note that the page turn works whether you are 
paging forward or backward in the project, but only works when you click 
the corners, not on the straight edges of the page.

 3. Return to InDesign so you can explore more page transition options. If you 
rely on the page curl to take a reader from page to page, you may find  
you don’t need navigation buttons in a simple document. But you’ll have 
to make sure they know to peel the pages by the corners, and that isn’t 
obvious. You may decide that, however cute the page curl might be, you’d 
still like to provide buttons as a more obvious method of turning pages. 
But that doesn’t mean you can’t still entertain the user during the page-
turning experience. It’s time to experiment with page transitions. In the 
Layers panel, reveal the Nav Buttons layer; “next page” and “previous 
page” buttons have already been created for you.

 4. In the Pages panel, select all seven page thumbnails. From the Pages panel 
menu, select Page Transitions > Choose to see the dozen page transition 
effects available (Figure 4.21). The examples themselves are animated; 
roll your cursor over one of the options to see the transition in action. 
Choose the Dissolve transition by clicking the radio button under its  
example, and click OK. 

Figure 4.21 Page transition 
options. Roll over each option, 
and the example becomes 
animated to show you the 
effect. Note the option to 
apply to all spreads. All 
page transitions translate to 
interactive PDF except the 
Page Turn transition.
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 5. If necessary, set the Preview panel to Preview Document mode. In the 
Preview panel menu, choose Edit Preview Settings and turn off the 
Include Interactive Page Curl option (Figure 4.22); the Page Curl option 
is on by default. Having the curl won’t prevent your page transition effects 
from working, but the cumulative effect of the Dissolve transition, the 
page curl, and the navigation buttons would probably be sensory overload 
for a reader. As they attempted to click the navigation button for the next 
page, the page would unexpectedly curl, then dissolve... well, it would just 
be too much. There’s something to be said for restraint. 

Figure 4.22 To test page 
transitions, turn off the Include 
Interactive Page Curl option. 
Remember this option if you 
do want the page curl and 
wonder why it isn’t working 
(the option is on by default).

  Click through the document in the Preview panel; what do you think of 
the Dissolve transition?

 6. If the twelve page transitions aren’t enough, you can customize the  
behavior of the transitions to shake things up (Figure 4.23). Open the 
Page Transitions panel (Window > Page Transitions), and select the Push 
transition. Click the Direction pull-down to see the options, and select the 
Right Up option. Click the Speed pull-down to see that you can choose 
from Slow, Medium, and Fast. Leave the Speed option at the default: 
Medium. Click the Apply to All Spreads icon in the lower-right corner of 
the panel, and check the results in the Preview panel.

NOTE: During export to SWF, 
you’re given the choice of using 
a Paper color or Transparent 
background. If you choose the 
Transparent option, all page 
transitions (including the page 
curl) are disabled. If your page 
transitions aren’t working, 
export settings are the likely 
culprits.
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Figure 4.23 You can customize 
page transitions by changing the 
speed and direction. Click the 
Apply to All Spreads icon (circled) 
if you neglected to select all 
spreads beforehand.

  Experiment with other transitions; edit them to see what works best for 
this document. You can even apply a different transition to each page. 
(Remember: just because you can, that doesn’t mean you should. Control 
the urge.) Pages with a transition assigned will display a small icon in the 
Pages panel (Figure 4.24). You can also choose page transitions from 
Layout > Pages > Page Transitions > Choose (they just hide these little 
goodies everywhere, don’t they?).

Figure 4.24 A small icon (circled) 
indicates which pages have been 
assigned page transitions.

 7. Even if you pull on the corners of the Preview panel for a larger preview, 
you should still export to SWF and view the results in a browser for the 
full effect. What looks amusing in the Preview panel may prove to be 
overwhelming at full size in the final state. Decide on the page transition 
(or transitions) that you feel would be suitable for this small catalog of 
an artist’s work, and choose File > Export. Choose Flash Player (SWF) for 
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the format, and navigate to the folder named Paintings (Your Version) 
inside the Page Transitions folder. Name the SWF Paintings.swf. In the 
export dialog, use the following settings:

■	 Generate HTML File: This enables you to view directly in a browser.

■	 View SWF after Exporting: Automatically displays the SWF in your 
default browser.

■	 Scale: 100%

■	 Background: Paper Color—even though the project has a charcoal 
gray background; if you check Transparent, page transitions won’t  
be included.

■	 Page Transitions: From Document, to preserve your choices. Note 
that you can select a transition from the pull-down menu, though,  
and override existing page transitions during export.

■	 Options: Uncheck the option to Include Interactive Page Curl.

 8. Page through the Paintings project in your browser and see what you 
think. Do you like the transition (or transitions) you chose? Do the page 
transitions enhance the reader’s experience, or do they compete for the 
reader’s attention, detracting from the paintings, which are the central 
subjects? You might even decide to dispense with the fancy transitions 
after all, and just let the reader move sedately from page to page using  
the navigation buttons. It’s up to you.

If you want to remove all page transitions and start over, select a page thumb-
nail (or multiple thumbnails) in the Pages panel and, from the panel menu, 
choose Page Transitions > Clear All. If you want to disable the page transition 
for a single page, the easiest way is to select the page thumbnail in the Pages 
panel, then right-click (Mac: Control-click) and choose Page Transitions > 
Clear Page Transition from the contextual menu.

TIP: Some of the animation 
effects may behave oddly when 
combined with a page transi-
tion—especially the page curl 
effect. You’ll get your first hint 
in the Preview panel. As you 
page through the project in the 
Preview panel, if animations are 
not appearing, or are behaving 
unexpectedly, test the file by 
exporting to SWF and preview-
ing in a browser. You may find 
that you have to dispense with 
either the animation or the as-
signed page transition. Some of 
the more common animation 
offenders are Fade In, Appear, 
Zoom in 2D, Swoosh, and the 
Fly-in presets. It’s just One Of 
Those Things you’ll have to con-
sider as you start creating more 
adventurous projects. The easi-
est way to combat this problem 
is to make it a habit to rely on 
buttons to navigate to the next 
or previous page, disabling all 
transitions, and let your anima-
tion imagination run wild.
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limitations, 146, 156
navigation buttons in, 163–167
overview, 145–147
pages/states, 160–163, 178–180
planning for, 156
scrubbable values in, 154, 165
sound in, 180–182
transitions in, 170–173, 180–182
user guide, 149
workspace, 147–149

Flash Classic Text, 129, 137
Flash CS5 Professional. See FLA
Flash Player, 2, 25, 131, 132, 133
Flash Player Projector application, 132
Flash Professional

editing in, 141–144
exporting to, 135–144
using Illustrator with, 211–216

Flatten Transparency option, 129
FLV format, 40, 41, 42
fonts, 22, 137, 191
formats. See also specific formats

audio, 48–49
images, 12
multimedia, 14
supported by Flash Catalyst, 146
video, 40–42

fps ( frames per second), 129, 213
frame rates, 129
frames

as buttons, 87–89
graphics, 15, 52, 87, 198–199
text. See text frames
unlocking, 208

frames per second ( fps), 129, 213
FutureSplash Animator, 2
FXP format, 146

G
Garbage In, Garbage Out (GIGO), 122
Generate HTML File option, 74, 127
Glass Buttons styles, 111
glow effect, 78–82, 157, 164–165, 169
Go To Destination action, 118
Go To First Page action, 118

Go To Last Page action, 118
Go To Next Page action, 30, 84, 88, 118, 208
Go To Next State action, 119
Go To Next View action, 119
Go To Page action, 30, 83, 85, 115, 119
Go To Previous Page action, 30, 84, 118, 208
Go To Previous Spread action, 8
Go To Previous State action, 119, 200
Go To Previous View action, 119
Go To State action, 119
Go To URL action, 83, 86, 91, 118, 154, 180
gradients, 106, 108, 109
graphic styles, 94–97
graphics, 123–126. See also Illustrator artwork; images

color space, 124
placing, 125
resolution, 125, 127
shapes. See shapes
snippets, 198
streamlining, 125–126
transparency, 124

graphics frames, 15, 52, 87, 198–199
grids, 153, 174. See also guides
groups

animations, 59–62
color, 100
layer, 156, 158, 173
objects, 16

guides. See also grids
HUD, 177
ruler, 177, 189
Smart Guides, 116–117, 200

H
hardware requirements, ix
headlines, animating, 209–210
Heads Up Display (HUD), 149, 153, 177
hex color system, 165
hexidecimal numbers, 165
HMTL (Hypertext Markup Language), 17, 165
Home button, 25, 115–117, 170, 204
hot spots, 76, 92
HTML files, 17, 74, 127, 130–131
HUD (Heads Up Display), 149, 153, 177
hyperlink destinations, 113, 114, 115–116, 195
hyperlink trigger, 195
hyperlinks. See also linked items

adding to documents, 193–197
appearance options, 196
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attaching to text/text frames, 197
behavior options, 196
color, 194, 195
considerations, 218
converting URLs to, 36
cross-references, 33–36, 194
indenting, 196
jumpline, 196–197
naming, 195
page anchor, 194
table of contents, 23
text, 194
text anchor, 195
URL, 194–195

I
Illustrator

creating button art in, 93–102, 204–205
round-tripping to, 182–185
symbols, 97–102, 174
using graphic styles, 94–97
using with Flash Catalyst, 174–185
using with Flash Professional, 211–216

Illustrator artwork. See also graphics; images
buttons, 80
exporting to FLA, 125
exporting to SWF, 125
importing into Flash Catalyst, 174, 175
importing into Photoshop, 204–205
layer visibility and, 80
modifying, 212–216
placing vs. pasting, 125
using in Flash Catalyst, 174–185

image handling, 137
images. See also graphics; Illustrator artwork

adding to slideshows, 198–200
aligning, 199
button. See buttons
formats, 12
importing. See importing
links, 198–199
poster, 10–12, 43–44, 48
resolution, 125, 127, 137

importing
content into Flash Catalyst, 147, 150
Flash animation into InDesign, 217
Illustrator artwork into Photoshop, 204–205
Illustrator content into Flash Catalyst, 174, 175
layer considerations, 157–159

motion presets, 69
Photoshop content into Flash Catalyst, 150, 157–159

InDesign
animation capabilities, 52–54, 217
buttons included with, 83–87
exporting to SWF from, 126–129

InDesign documents. See also documents
adding hyperlinks to, 193–197
adding videos to, 210–211
adjusting layout, 123, 188–191
dimensions, 122–123, 189–190, 218
importing Flash animation into, 217
print, 123, 188–193

InDesign libraries, 83
Interactions panel, 154, 164, 169
interactive page curl, 127–128
interactivity, 127, 137, 146
intranets, deploying to, 130–131

J
JavaScript, 52
JPEG compression, 129, 137
JPEG format, 129, 137
jumpline hyperlinks, 196–197

L
labels, button, 152, 153, 169, 178
layer comps, 107–111, 205
layers

button, 101–102
in Flash Catalyst, 157–159, 167, 173
groups, 156, 158, 173
importing and, 157–159
multilayer buttons, 103–113
in Photoshop, 157–159, 173
styles, 103–111
visibility of, 80, 89, 113, 157, 161

Layers panel, 105
Layout Adjustment feature, 123, 188–191
Library panel

Flash Catalyst, 174, 180
Flash Professional, 141

Line tool, 64
Link Harmony Colors icon, 99
linked items. See also hyperlinks

images, 198–199
table of contents, 26–28
to video, 13
web links, 25, 36, 219
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Links panel, 44, 91, 198
Live Corners option, 93
Live Preflight feature, 188

M
Macromedia, 2
mailto format, 83, 116, 118
masks, vector, 103, 112, 202
master objects, 125–126
master pages, 29, 113, 205–208
media, 127, 137
Media panel, 10–14, 210
Media Player, 24
monitor resolution, 122–123
Motion Editor panel, 143–144, 214
motion paths, 6, 7, 61–67, 209–210
motion presets, 5–6, 64–69, 140, 214
Motion Tween controls, 213, 215
mouse, two-button, 85, 87, 88
mouseovers, 42, 78
.mov extension, 40
movie clip symbols, 137, 140, 212
movies. See video
MP3 format, 48
MP4 format, 40
MPEG format, 40
multimedia, 39–49, 91, 124, 137
multimedia files, 10–14, 127, 130
multistate objects, 119, 198–200, 220

N
navigation

considerations, 219
options for, 22–23
page transitions. See page transitions

navigation buttons. See also buttons
actions. See button actions
adding to master pages, 113, 205–208
creating button art in Illustrator, 93–102, 204–205
creating for online documents, 25, 28–31
creating in Photoshop, 201–205
in Flash Catalyst, 163–167
rollover effects, 31–33, 58

navigation controls, 117, 219
navigation points, 44–46
navigational bars, 83
navigational controls, 24–38
New Hyperlink dialog, 195–196
next page buttons, 23, 70–72, 204, 208
Normal button state, 80, 81, 85, 88, 90, 92

O
Object Layer Options command, 80, 81, 110, 112
Object States panel, 200
Object Styles panel, 14–17
objects

adding on top of video content, 47–48
adding to all states, 170
aligning, 15
animated. See animation
converting to buttons, 30, 46, 200
graphic styles, 94–97
master, 125–126
multistate, 119, 198–200, 220
naming/renaming, 4, 13
repositioning, 47
rotating, 47
states, 14–17

On Blur event, 77
On Button event, 55, 58–59
On Click event, 55, 57–58, 76, 77
On Focus event, 76
On Page Click event, 55, 56–57
On Page Load event, 55–56
On Release event, 30, 76, 77, 78
On Roll Off event, 76
On Roll Over event, 55, 58, 76
opacity, 62, 102
Open File action, 119
Options setting, 129

P
Page Anchor option, 193
page curl effect, 70–72, 126, 127–128
page dimensions, 122–123, 189–190, 218
Page hyperlink destination, 115
page numbers, 85
Page Range option, 126
page transitions

considerations, 219
duration, 172, 173
exporting and, 73–74, 127
fading, 171–172, 173
in Flash Catalyst, 170–173
previews, 72, 73
smooth, 172–173
working with, 70–74, 127

pages
alternate content, 160–163
automatic numbering, 85
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continuing across multiple, 196–197
creating pages/states, 160–163, 178–180
facing, 205
Go To Page option, 30, 83, 85, 115
master, 29, 113, 125, 205–208
rasterizing, 129
spreads, 8, 88, 191–192
transitions. See page transitions
vs. states, 160

pages/states, creating, 160–163, 178–180
paragraph styles, 28
Paste dialog, 213
pasteboard, 48
Path Selection tool, 202
paths

Bézier, 5, 61, 63
clipping, 202
motion, 6, 7, 61–67, 63, 209–210
selecting, 202

patterns, 107–108
PDF actions, 119
PDF files

button events for, 76–77
embedding SWF files in, 24
interactive, 38, 48
layer visibility and, 80
placing InDesign pages via, 89–90
saving as Photoshop PDF, 112

PDF format, 38, 39, 119
PDF-Only actions, 119
Pen tool, 65
Pencil tool, 65
Photoshop

blending modes, 102–103
button creation, 201–205
creating button art in, 102–112
import options, 158–159
importing Illustrator artwork into, 204–205
layer considerations, 157–159, 173
saving as Photoshop PDF, 112

Photoshop files
blending mode attributes, 102
in Flash Catalyst, 157–173
importing into Flash Catalyst, 150, 157–159
layer visibility and, 80, 157, 161
placing vs. pasting, 125

pixels, 189
Place dialog, 89–90, 96
Place PDF dialog, 89–90
play controls, 7, 8–10

Play on Page Load option, 217
playing animations, 8, 9, 10
PNG format, 137
poster images, 10–12, 43–44, 48
Poster option, 217
preflight errors, 188
presentation, 20–22
presets

animation, 74
document, 21
motion, 5–6, 62–69, 140, 214
zoom, 119

Preview panel, 7–8, 72, 88, 193
previews

animation, 7–8
checking documents with, 88, 193
keyboard shortcuts, 88
page transitions, 72, 73

previous page button, 23, 29–30, 204
print documents, 20–22, 123, 188–193
print/web projects, 188–193
project checklist, 218–220
project folders, 130–131
Projector files, 132
projects

deployment, 24
distribution, 130–132
exporting to SWF, 218–220
print/web, 188–193

Properties panel
Flash Catalyst, 150–152, 164–165, 168
Flash Professional, 141

.psd extension, 80
Publish to SWF/AIR command, 154–155, 173, 216

Q
quality, JPEG, 129
QuickTime files, 40–41

R
raster effects, 94, 129
Rasterize Pages option, 129
Recolor Artwork dialog, 98–100
Rectangle tool, 103, 150–151, 152
resolution

considerations, 122
export options, 129
graphics/images, 125, 127, 137
monitor, 122–123
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Resolution option, 129
_Resources folder, 130
RGB color, 94, 122, 124, 174, 191
RIA (Rich Internet Applications), 146
Rich Internet Applications (RIA), 146
rollover effects, 31–33, 58
Rollover state, 77, 79, 81, 85, 88–90, 208
Rounded Rectangle tool, 103
ruler guides, 177, 189
rulers, 171, 180, 213

S
Sample Buttons library, 83–87
Save As command, 16, 69, 123, 212–216
Scale option, 74
scripting

ActionScript, 2, 140, 143, 212
AppleScript, 52
JavaScript, 52
sample scripts, 52–54
VBScript, 52

scroll panels, 175–178
Select tool, 150–153, 169, 176, 180
Selection tool, 213
servers, deploying to, 131
shadow effect, 105, 106, 157, 211
Shape layers, 112, 202
shapes

buttons, 92–93, 152
constraining, 202
drawing, 152
vector, 201

sharpness, 112
Shockwave Flash. See SWF
Show/Hide controls, 31, 32, 33, 79, 80, 118
Shuffle option, 192
Size option, 127
slideshows

adding images to, 198–200
creating, 198–200
multistate objects, 14–17

Smart Guides, 116–117, 200
snippets, 198
software requirements, ix
sound. See audio
Sound action, 119

spot colors, 124, 191
spreads, page, 8, 88, 191–192
sRGB color, 191
stage, 141
states. See also button states

adding objects to, 170
creating pages/states, 160–163, 178–180
objects, 14–17
Rollover, 81, 85, 88–90, 208
vs. pages, 160

streaming video, 46
stroke attributes, 94
styles

buttons, 111
fonts, 191
graphics, 94–97
layers, 103–111
paragraphs, 28

Styles panel, 105
swatches, color, 100, 191
Swatches panel, 191
SWF actions, 118–119
SWF files

companion HTML files, 38
deploying, 130–132
emailing, 24
embedding in PDF files, 24
exporting, 2, 136, 139
playing in Media Player, 24
viewing in Web browsers, 24, 25, 26

SWF format
exporting finished projects to, 218–220
exporting Illustrator content to, 125
exporting to, 36–38, 40, 126–129

SWF-only actions, 119
symbol libraries, 98
symbols, 97–102, 174
Symbols panel, 97–98, 212

T
table of contents, 23, 26–28, 114–115
text

animating, 209–210
captions, 200
on curved path, 65
Flash Classic Text, 129, 137
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size, 191
Text Anchor hyperlink destination, 116
Text Anchor option, 193, 195
text frames

converting to buttons, 92–93
creating in Flash Catalyst, 151, 169

Text Layout Framework (TLF), 137
Text option, 129
text tools, 167, 169, 176
Timeline, 141
timeline controls, 171, 213–216
Timeline tab, 213–215
Timelines panel, 148, 170–173, 180–181
Timing panel, 8–10, 68
TLF (Text Layout Framework), 137
Tools panel, 103–104, 167, 168
Transform Proxy option, 93
transitions

in Flash Catalyst, 170–173, 180–182
page. See page transitions

transparency, 102–103, 124, 129
transparent backgrounds, 127
transparent effects, 191
triggers

animation, 55–62
button. See button triggers
event, 6–7, 55–62, 76–82
hyperlink, 195

“Twinkie finger,” 87
two-button mouse, 85, 87, 88
Type tool, 151

U
Underline option, 194
Up state, 77
URL hyperlink destination, 116
URL hyperlinks, 194–195
URLs

converting to hyperlinks, 36
Go To URL action, 83, 86, 91, 118, 154, 180
viewing in web browsers, 24, 25, 86–87, 118

V
VBScript, 52
vector art, 122, 174
vector edge, 112
vector masks, 103, 112, 202

vector shapes, 201
video, 40–48

adding objects on top of, 47–48
adding to InDesign documents, 210–211
colorizing, 47
considerations, 219
embedding, 13
exporting for Flash output, 16
fade-ins, 13
links to, 13
navigation points, 44–46
placed, 11, 12
posters, 43–44
QuickTime, 40–41
streaming, 46
triggering with buttons, 45–46, 59, 210–211
working with, 10–14

Video action, 119
video formats, 40–42
View SWF after Exporting option, 74, 127
View Zoom action, 119

W
Web

deploying to, 130–131
repurposing print documents for, 188–193
viewing SWF files on, 26

Web browsers
Flash Player plug-in, 131
Go To URL action, 86–87, 91, 118, 180
viewing SWF files, 24, 25, 26

Web hosting server, 131
Web intent, 122
web links, 25, 36, 219
Web styles, 111
web/print projects, 188–193
workspaces

Flash Catalyst, 147–149
interactive, 3
interactive for PDF, 3
listed, 3

Z
zoom controls, 119
zoom options, 115
zoom presets, 119



Watch
read

create
Meet Creative Edge. 
a new resource of unlimited 

books, videos and tutorials for 

creatives from the world’s  

leading experts.

creative edge is your one 

stop for inspiration, answers to 

technical questions and ways to 

stay at the top of your game so 

you can focus on what you do 

best—being creative. 

all for only $24.99 per month  

for access—any day any time  

you need it.

peachpit.com/creativeedge


	Table of Contents
	Introduction
	Who Should Read This Book
	What You’ll Get Out of This Book
	What This Book is Not
	Software Requirements
	About the Exercise Files
	Acknowledgements

	Chapter 4 Animation
	What Can Be Animated?
	Events
	Motion Presets
	Page Transitions

	Index
	A
	B
	C
	D
	E
	F
	G
	H
	I
	J
	L
	M
	N
	O
	P
	Q
	R
	S
	T
	U
	V
	W
	Z




